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OVERVIEW

The SituationAnalyst (SA) application is an integrated tactical and operational decision support
tool used for wildland fires. SA combines a traditional "common operational picture" with
collaborative mapping, geospatial and imagery analysis, and analytical reporting.

SituationAnalyst (SA) application provides multiple Navigation panes with different tools to
maneuver and adjust map data. Click on an icon to open and close the feature window:

o Left side navigation panel

e Bottom right navigation icons

The Top Left Menu includes the following features to manage available layer on a map:

B

2 1 2. Briefing Mode: Summary for active incidents which includes resources and
activities.

R N

. Application Icon: Hide or display the left side menu panel

3 @ 3. Manage Layers: Manage layers visible on the map
4 ,,//P 4. Edit: Add Features and Layers

5 41 5. Tools: Measurement options and data search

The Bottom Left Menu includes the following features to access a map:

1 7 1. Help: Links to the FAQ Section on the Help Page

2 i= | 2. Legend: Key that list what the symbols represent on the map

3 3. Workspace: Contains specific layers and data available on a map

The Right Navigation Icons: Reposition the view within the map.

1° 1. ZoomIn
2° 2. Zoom Out

3 @ 3. Zooms to the user’s location
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How TO LOG ON

Step 1: Go to https://egp.wildfire.gov/egp/Default.aspx

Step 2: Click or tap on Click here to log in via FAMAuth

Log in to your EGP Account

Click here to log in via FAMAuth

Step 3: Authentication access using the appropriate option.
a. All Partners without govt. credential click or tap Login.gov

b. All govt. credential users click or tap e-Authenticate

Public Partners Government
Login.gov is a service that eAuthentication is the system
offers secure and private that allows users access to
online access to government Wildland Fire Apps and Services
programs through a Private using government clearance.

Mon-Federal account.

Step 4: On the EGP page click or tap the SituationAnalyst (SA) link under Quick Launch

QUICK LAUNCH

= FireGlobe

= _Lightning Viewer

» SituationAnalyst (SA)

= Airtanker Base Directory
= Fire EGP Data
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BRIEFING MODE

The Briefing Mode Dashboard is accessible from the top left menu panel. The tool provides both
a strategic and operational overview summary about active incidents, resources, and response
activities. Incident information is pulled from the Integrated Reporting of Wildland-Fire
Information service (IRWIN). The NICC Sitrep link opens the Incident Management Situation
Report (IMSR).

The data displayed in the Briefing is based on the visible mapped area. The Briefing data
automatically updates, when a user zooms in or out on the map to another region or district
reflecting the new mapped area.

1. Click or tap on the Briefing Mode icon to open the feature.
2. Map automatically opens at National level.

3. Click or tap on the GACC Region, colored dot, or zoom in or out to the desired location
on the map.

4. A new location tab will appear next to National tab, and the Briefing summary data will
update to the new mapped location (e.g. National — Southern GACC Region).

5. The Legend is at the bottom of the screen.
6. Click or tap on the previous location name in grey to go back to the previous screen.

7. Click or tap on the X or Briefing Mode icon to close this feature.

= @ Intterra Maps

Southern

PREPAREDNESS Active ___ Initial
LEVEL Large Fires  YPEV/ZFITEs ey

16 0 10

3 NICC Sitrep

Incidents

2 N © D

@eres Bumed T)

Smokehouse
Creek
1,059,570 acres

1,059,570 acres 313 Personnel
53442910 2 Engines

? Contained ? Structures Threatenad
=

{ View

Windy Deuce
144,206 acres

Catesby Fire
89,688 acres

Grape Vine Creek
34,882 acres

| © =24Hour @ Initial Attack @ \MSRl
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BRIEFING INFORMATION

A data summary is found at the top of the dashboard; to view more in-depth details click or tap
on the Incident or Overview button. The legend is located at the bottom of the screen.

DASHBOARD SUMMARY INCIDENT DATA OVERVIEW DATA
SECTION TAB TAB
Nati } Southem @ Incidents Qverview C Incidents Overview
N — Preparedness Level: 3
Southern (A'-r‘-‘s Bumed - ) Inftial Attack Activity 10
Active Large Fires: 15
PREPAREDNESS Active Type1/2Fies il e 172 o 0
LEVEL Large Fires ! Aitack Smokehouse Sit-209 Resources
1 6 0 8 Creek Area command teams committed: 0
3 1,059,570 acres NIMOS Gammitted: 0
Type 1IMTs committed: 0
NICC Sitrep 1,059,570 acres 313 Personnel Type 2 IMTs committed: o
f Incidents §3,442910 ? Engines IROC Committed Resources
? Contained ? Structures Threatened Type 1 Crews: 78
Type 2 Craws: 224
Engines (IV/VVI/VIT) 32/18/880/16
Dozers (/17I1/1V): 12/100/108/12
687 Reamer Helicopters (1/1/11): 22/48 /156
2,000 acres ir Tankers (I//IVE: 10/2/80/80
Fixed Wing: 358
@ >24Hour @ Initial Attack @ IMSR

DASHBOARD SUMMARY DATA:

|| e Briefing Mode Icon
@ Mm e Location for displayed information

<> | Southern e Preparedness Level
=
_| | PREPAREDNESS  Active Tvoe 1/2Fires Al e Number of Active Large Fires

LEVEL LargeFires  P° ST attack -

V4 e Type of /2 Fires
16 0 8 -
e [nitial Attack

]

NICC Sitrep « NICC Sitrep link to the IMRS

e Incident and Overview buttons

Incidents Overview

INCIDENT TAB:
The Incident tab provides an itemized list of impacted areas. When additional data is available
such as Assessment Information and Weather Data for a location, a color bar will be visible
next to the location name.

1. Click or tap the Incident button.

2. Click or tap the dropdown caret next to Acres Burned to change the analytics.
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Click or tap the Location name for the location summary.

If the location has a gold bar, click or tap the View button to see the following

Information:

¢ Incident Summary overview
¢ Incident Information

e Assessment Information

e Committed Resources

e Detailed Information

Click or tap on the previous location name in grey to go back to the previous screen.

Click or tap the X or Briefing Mode icon to close this feature.

Example below is for the Southern Region Incident Summary

INCIDENT DATA

VIEW BUTTON DETAILS

Nati

South

X

Southem

ern

W

PREPAREDNESS Active - Initial
LEVEL Large Fires ~ WYPe1/2Fires oy
3 MICC Sitrep
( Acres Bumed I )
M
Smokehouse
Creek

1,059,570 acres

1,059,570 acres 313 Personnel
$3,442910 7 Engines
? Contained ? Structures Threatened
[ =
)

687 Rea

mer

E)EEED)
Smokehouse Creek

Incident #:

IRWIN ID:

Incident Size: 1.039572+006
% Contained: o

Team .
Type/Complexity: Type 31C / Type 3 Incident
Unified: False

Sit-209 Report

Date (UTC):

Sit-209 Report U

Status:

Incident

Type/Kind: AL
Estimated Cost

to Date:

Total Personnel 276

I Incident Information |

Discovery Date

[uTc):

- Human Power
Cause: generation/transmission/distribution
Dispatch Center: TXTIC
Dispateh
Complete N
Local Incident 102
County:

Land Owner Private Private
Jurisdictional

Unit:

Last Time

Information

Modified (UTC):
|Assessmem Information |
Fatalities: 1
Injuries: o
Residences a
Destroyed:

Residences 0
Threatened:

Other Structures | o
Destroyed:

Other Structures
Threatened: 1000

$§it-209 Committed Resources
erhead: 14
Type | Crews: o
Type Il Crews: 0
Engines: 13
Dozers: 4
Helicopters
(uny: o/o/o
Air Tankers
(i p/on
Fixed Wing o
| IROC Commiitted Resourcesl
ype 1 Crews: u
Type 2 Crews: 0
Engines (1/11/111) 0/0/0
Engines
(NPT o/o/0/0
Dozers
(v 0/0/0/0
Helicopters
(vuny: o/o/o
Air Tankers
A o/0/0/0
Fixed Wing o

| Detailed I!nfom'l.ationl

Correct entry for Box 10is "Type 1
Incident.” The correct entry will not stay
saved. It reverts back to default.
\Weather forecast for the next couple
days provides fairly light winds, cool
temperatures, and an increasing chance
of precipitation that will continue to
provide low-moderate potential fire

ICS-209 Remarks

behavior. Residual pockets of heat are
present across the fire area that may
become active with wind influence. Heat
sources are primarily located in
Cottorwood free patches and brushy
areas in gulches and drainage bottoms.
Continued flare-ups aleng the perimeter

Significant
Events

are possible as pockets of residual
woody fuels continue to smolder and
contact arass fuels.
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OVERVIEW DATA

The Overview tab shows a summary of details available for the active incident based on the
current mapped level. The details include both the SIT-209 and IROC committed resources.

1. Click or tap the Overview button.
2. Click or tap on a color dot on the map to see the location’s Overview details.
3. Click or tap on the previous location’s name in grey to go back to the previous screen.

4. Click or tap the X or Briefing Mode icon to close this feature.

OVERVIEW BUTTON MAPPED AREA WITH SELECTED DOT’S

LOCATION DOTS LOCATION OVERVIEW

DR X

X
e

Southern Grape Vine Creek

Incident #: 2024TATXS240319
IRWIN 1D B6FBY9BB3-55FD-4A0E-8712-

B66259F747AB

Incident Size: 34883
Preparedness Level: 3 % Contained: 60
Initial Attack Activity: Team . e
Active Large Fires: Type/Complexity: | 1¥P€41C/ Type 4 Incident
Type 1/2 Fires: 0 U_mfled False

ggé‘ﬁ?gf"“ 03/08/2024 001658

5it-209 Resources
Area command teams committed: 0 Incident Information
MNIMOs committed: 0 Discovery Date s
Type 1 IMTs committed: 0 uTC): 02/26/2024 21:10:24
Type 2 IMTs committed: 0 Cause: Human Power
: generation/transmission/distribution
IROC Committed Resources g:gg:g: Center. | TXTIC

Type 1 Crews: 76 Complate No
Type 2 Crews: 224 Local Incident ID: | 240319
Engines (I/11/111) 0/0/68 —
Engings (IV/V/VIVI: 327187880/ 16 Assessment Information
Dozers (I/I1/11/1V): 12/100/108/12 Fatalities: 0
Helicopters (1/11/111): 22/48/136 Injuries” i}
Air Tankers ([/1/NAV): 10/2/80/80 Residences 0
Fixed Wing: 358 Destroyed:

Nuarhasd- T 11
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Layers are visible datapoints on a map. When the SA application opens it opens to the Active
Incidents (ai) Workspace Layers menu with specific layers turned on or off. The Layers Menu is
dynamic and displays specific data in each Workspace.

A user can customize the Layers Menu to expand, narrow, or change the basemap by turning on
and off a specific layer(s) or adding a layer from a different workspace to multiple workspaces. A
blue bar next to the layer name indicates the layer(s) is turned on, the absence of the blue bar
indicates the layer is turned off. The user can change the Workspace as well as add layers from

one Workspace to multiple Workspaces.

Any changes a user makes to customize their layers or map, including adding layers to multiple
Workspaces will be lost once the SA application is closed.

= © Intterra Maps A

- Q. Find Layers & Places > ‘
-

@ Layers €83

7 Add Layer >
Basemap: Streets @

kol —
Active Incidents ~ >
Display Incident Mapping (AGOL) ~ \ J

WFIGS - Wildland Fire Perimeters Current Year (All) L

WFIGS - Wildland Fire Perimeters Current Year (Fin_.

WFIGS - Wildland Fire Perimeters Current Decade 3, e -
Airborne Intel Mapping - 40Y 2| 5

okehouse &W
Airborne Intel Mapping - 0AG o ] -

Texica
Airborne Intel Mapping - 327/328 e - ;
Airborne Intel Mapping - 00V

Paso._»
Airborne Intel Mapping - 43U/578 .
Airborne Intel Mapping - 17v/112 b

A uehus

°
Airborne Intel Mapping - 15Z b @

L2

Airborne Intel Mapping - 7PG

Airborne Intel Mapping - 6KQ/65E

>
Airborne Intel Mapping - 8XY =
Py
.t
2 Hazardous Fuels Treatmeants o
®
Historical Fire Data - 2010s b
= . ®_ s
= |
|.: Historical Fire Data - 2000s -
Historical Fire Data - 1990s

Historical Fire Data- 19580s
Historical Fire Data - Before 1980

National 1A Frequency Zones

Inciweb

IR Alerts

I Thermal IR Detects ~

CA Tree Mortality

RAWS Mobile

Barlow Canyun
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Use the following steps to open the Manage Layers Menu, see sub-layers and changes to the

Manage Layes menu by changing the Workspace.

1.

2. Click or tap the caret next to the layer name to see the sub-layers

| Q. Find Layers & Places ... >
@ Layers &

/ Add Layer >
Basemap: Streets

i @

v

Active Incidents ~
Display Incident Mapping (AGOL) ~

WFIGS - Wildland Fire Perimeters Gurrent Year (All)
WFIGS - Wildland Fire Perimeters Current Year (Fin...
WFIGS - Wildland Fire Perimeters Current Decade

Airborne Intel Mapping - 40Y

National [A Frequency Zones

Inciel

IR Alerts
I Thermal IR Detects ~

CA Tree Mortality

RAWS Mobile

NowCoast Radar

Click or tap the Manage Layer icon to open the Layers Menu

Find Layers & Places

| Q

@ Layers

‘# A00 Laysr
o~

Basemap: Stresis
il

Acfive Incidents

Layers
Add Laye
Basemag Sihedls

Actve Incigents

Lange IMSR Tipe 1
Large IMER Typa 2
Lamge ISR Criher
ifer 209
Emmengireg <24 hours

Emarging >24 hours

}
& @
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3. To change the Layers Menu, click or tap the Workspace icon, click or tap on a new
Workspace and the Layers Menu automatically refresh to match the new workspace.

Workspaces Q. Find Layers & Places ...
Ll
? i Layers iy
/ Add Layer >
- —
Basemap: Strests .
il
Active Incidents S

Mational |A Frequency Zones

Thermal IR Detects

ELM Lightning Services

BLM Lightning - 12 Hours

BLM Lightning - Animate

NWS SurfaceObs

MowCoast Rainfall Estimates

MowCoast Radar

US National Grid

©

TURN LAYERS ON OR OFF

A blue bar next to the layer’'s name indicates the layer is turned on.
1. Scroll to the layer name to be turned on.

2. Click or tap on the layer to turn it on.

];[ Q. Find Layers & Places . ><
@ Layers e
Y Add Layer >
Basemap: Streets
. @
Active Incidents N
Display Incident Mapping (AGOL) N

WFIGS - Wildland Fire Perimeters Current Year (All)
WFIGS - Wildland Fire Perimeters Current Year (Fin...
WFIGS - Wildland Fire Perimeters Current Decade

m{gome Intel Mapping - 40Y
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3. The bar next to the layer name will turn blue.

LJ

4
a

Q. Find Layers & Places ... ><
Layers 53
Add Layer >
Basemap: Streets .
Active Incidents W
Display Incident Mapping (AGOL) v

WFIGS - Wildland Fire Perimeters Current Year (All)

WFIGS - Wildland Fire Perimeters Current Year (Fin...

WFIGS - Wildland Fire Perimeters Current Decade N

gg'lj:orne Intel Mapping - 40Y

SITUATIONANALYST (SA) USER GUIDE

4. Click or tap on the layer name with the blue bar to turn it off, the blue bar will disappear
indicating it is off.

-

4
o

Q. Find Layers & Places ...

Layers

Add Layer

Basemap: Strests

Active Incidents

Display Incident Mapping (AGOL)

WFIGS - Wildland Fire Perimeters Current Year (All)
WFIGS - Wildland Fire Perimeters Current Year (Fin...
WFIGS - Wildland Fire Perimeters Current Decade

.-ﬁrjgome Intel Mapping - 40Y

X

v @

ADD A NEW LAYER

This feature allows the user to incorporate additional pieces of data to the mapped area.

Note: Any added layers will be removed upon refresh or changing the workspace.

CONFIDENTIAL
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ADD ARCGIS ONLINE URL
1. Click Add Layer

SITUATIONANALYST (SA) USER GUIDE

];[ Q. Find Layers & Places ... ><
@ Layers 5
# | [potaer >

2. Enter layer’s url, use prepopulated name if available or type in a new layer name, then

click the Add button.
< X x
Add Layer Add Layer
I
layer url https:/fservices1.arcgis.com/991lidPhWCzftle9k/arcgis/rest/
layer name I Utah Roads
—
| | Arcais ArcGIS
[ | KML/KMZ KML / KMZ
[ ] WMS WS
( Browse... ) ( Browse... )
Add From ArcGIS Online S

3. A notification will appear in the upper right corner that the layer was added.

B ,

Iy
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4. Use the back arrow < to see the added map data; the new layer name is at the bottom of

the list.

ADD A COMPUTER FILE

1. Click Add Layer

| Find Layers & Place: X
@ Layers
f | Add Layer >

2. Click the browse button

<
Add Layer

| | ArcGls
[ ] KML/KMZ
[ | wms

Browse... P

Add From ArcGIS Online

3. Select the KML, KMZ or Zip shape file and click or tap Enter

KMZ FILE ZIP SHAPE FILE

iPC 5 05(CY »

jder

2 20220028 Sedr Creek

| Custom files

Upload from mobile | [ 0pen

ThiePC » OS(C) » Werkepace » FM

JE > TR

» TR _Ten

[

| 7 hétp_downioad_ 1707932661458 _36263

e nsme: | hitp downlead TT07332561458 36268

CONFIDENTIAL — FORINTERNAL USE ONLY
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4. A notification will appear in the upper right corner that the layer was added.

.....

5. Use the back arrow < to see the new mapped data.

Q,  Find Tools & Places . X
Tools
|
Measure >
Search Layers 7 |
|
IR Alert Summary >
|
|
Airborne
60-day Hi: > ‘
Satellite Intel 5 ‘
365 Days |
|
|
|
|
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ADD LAYER TO MULTIPLE WORKSPACES

1. Click or tap the Layer
2. Click or tap Details

Display Incident Mapping {4G0L)
| | oomas ] |

3. Check the Keep in All Workspaces box

LAYER OPACITY

KEEF IN ALL —
WORKSPACES

L a1 e -

CoOMMON LAYERS
All Workspaces contain the following layers unless noted:
e Active Incidents
¢ Display Incident Mapping (AGOL) ArcGIS (Geographic Information Systems) Online—
provide incident specific features which include Helispots, fire perimeter, fire

containment, division breaks, hazardous area, dozer lines, drop points, etc.

o WIFIGS - Wildland fire perimeters for current year to date, current decade (fires from the
last 10 years)

ACTIVE INCIDENTS (Al) - DEFAULT LAYER
The Active Incidents layer is the default layer and available in every Workspace. It includes:
e Current location(s) of all active fires
¢ Thermal Detect ** - MODIS, VIIRS, Hawkeye Satellites images available
e Airborne Intel collected within the last 48 hours
AVIATION (AV)
¢ ATU Retardant drops with fixed or rotor wing
¢ NICC (National interagency Coordination Center) Active Resources

e Short-Haul, Temporary Flight Restrictions, Military Training Routes, etc.
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e Thermal Detect ** - MODIS, VIIRS, Hawkeye Satellites images available

LIGHTNING (LI)
This Layer is not the same as the Lightning Viewer application.
¢ Lightning strikes for specified time periods
o Thermal Detect from MODIS, VIIRS, Hawkeye Satellites images available

Note: This layer does not contain Display Incident Mapping AGOL (ArcGISOnline) or
WFIGS layers
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WORKSPACES

The purpose of the Workspaces feature is to combine related data and tools together in a single
place. Changing the default workspace from Active Incidents to a different workspace allows the
user to access more layers and tools for a specific workflow.

From the Workspaces menu a user can use the application links to launch the application
outside of SA or change their Workspace.

Lo ] Apps: Quick Launch Links outside of SA
| Maps
EGP Portal Workspaces:
Flight
Short-Haul ai: Active Incidents (Default Workspace)
? FireGlobe
Lightning Viewer ps: Predictive Services
CFETS . .
— ATBDirectory ir: Intelligence & Resources
= av: Aviation

fp: Fuel and Planning
li: Lightning
nhaz: Naturalhazards

\“)

ACTIVE INCIDENTS (Al)

This default Workspace is configured to provide users with the location details for active
incidents to gain situation awareness.

e General spatial awareness
e Historical data
e Thermal spatial awareness

PREDICTIVE SERVICES (PS)

Configured to provide weather activity data to help users determine a tactical approach for fire
activities.

¢ NowCoast related data
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e Lightning activities

INTELLIGENCE & RESOURCES (IR)

Configured to provide in-depth Intelligence for fire operations to gain situation awareness.

e Airbourne collected videos and imagery
e Fireguard perimeters
e Resource tracking

AVIATION (AV)

Configured to provide aviators with flight planning information in preparation for missions as well
as retardant drop locations.

e Automated Telemetry Units (ATU) data (link)
e Weather
e Temporary flight restrictions

FUELS AND PLANNING (FP)

Configured to provide prescribed fire treatment tools and information for burning operations.

e Potential operational delineations (PODs)
e Hazardous fuels treatments

LIGHTNING (LI)*

Configured to provide lighting and thermal detection data from the Satellites to gain situation
awareness.

*Note: The lightning Workspace is different than the Lightning Viewer application.

NATURAL HAZARDS (NHAZ)

Configured to provide data for natural hazards identified by FEMA, related to the Emergency
Support Function (ESF) #4 level, to coordinate assistance for a national response.

e NowCoast Data
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MAPS

EXPORT DATA

1. Open the Workspace and select desired layers

Q. Find Layers & Places ... ><
Layers &
Add Layer >
Basemap: Strests .
Active Incidents N
Mational |A Frequency Zones
Thermal IR Detects L
ELM Lightning Services
BLM Lightning - 12 Hours N

BLM Lightning - Animate

NWS SurfaceObs

MowCoast Rainfall Estimates

MNowCoast Radar

LIS Mational Grid

SITUATIONANALYST (SA) USER GUIDE

2. Click or tap on the Gear icon, then click or tap the Cloud icon

Layers

-

i
S |

Se{“j Export

§ i

rgh

3. Select the layers needed for the data

CONFIDENTIAL — FORINTERNAL USE ONLY
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Export Map

Layers
\ctive Incidents (39)
fhermal IR Detects (1270) .

8L Lightning - 12 Hours (VF

|
4. Enter the e-mail address(es) where the file is to be sent, using a comma to separate
multiple e-mails.

5. Click or tap the File GDB or Shapefiles button and click or tap Export.

Email’|
. [@usda.gov, @usda.gov, smokey bear@usd a.go]

I' Export Format'l
( Geospatial PDF File GDB Shapefiles )

- |G

6. An e-mail will be sent to the requestor(s) within 15 minutes with the link expiration date.

From: donotreply@eros.nweg.gov <donotreply@eros.nwcg.gov>
Sent: Tuesday, February 27, 2024 1:35 PM

Subject: File GDB export from Intterra

You have received a File GDB export from Intterra

Download File GDB exporf]

|' This link will expire on 03,/12,/2024 18:34 UTC |
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EXPORT A GEOSPATIAL PDF MAP

1. Open the Workspace and select desired layers

Q. Find Layers & Places ... X
Layers 8
Add Layer >
Basemap: Sireets 4 .
Active Incidents N

Display Incident Mapping (AGOL)

WFIGS - Wildland Fire Perimeters Current Year (All) N

WFIGS - Wildland Fire Perimeters Current Year (Fin...

WFIGS - Wildland Fire Perimeters Current Decade

Airborne Intel Mapping - 8XY

I Hazardous Fuels Treatmenis N |

2. Click or tap on the Gear icon, then click or tap the Cloud icon

Layers
|G
Layer s Evor

3. Select the layers needed for the map

Export Map
Layers

4 ctive Incidents (116) "

iplylncident Mapping (AGOL) - layer type not supported

—

azardous Fuels Treatments - layer type not supported
hermal IR Detects (3210) i

Note: Layers with the message layer type not supported will not be included in your
export.
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4. Enter the e-mail address(es) where the map is to be sent, using a comma to separate

multiple e-mails.

5. Click or tap the Geospatial PDF button and click or tap Export.

Email
. smokzey.bear@u sda.gov, @usda.gov

Export Format

Geospatial PDF File GDB | Shapefiles

)

File Name
[ 03.11.24_lightning Mar] ]

Export Size
| Default (Extent of Map) v|

area you wish to export.

Only features in the current map extent will be added to the PDF. IT you
want more or fewer features fo appear, close this dialog and zoom to the

6. An e-mail will be sent to the requestor(s) within 15 minutes.

From: donotreply@eros.nwcg.gov <donotreply@eros.nwcg.gov>
Sent: Monday, March 11, 2024 5:05 PM

Subject: Geospatial PDF from Intterra

You have received a Geospatial PDF from Intterra

Download Geaospatial PDF|

| This link will expire on 03/25/2024 22:04 UTC |
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LEGEND

The legend informs the user what the symbols on the map represent, it is also dynamic, which
means availability and information will vary based on the open Workspace. When available the
Legend icon will be in the bottom left menu panel.

An additional feature with the legend is the ability to undock a legend and move it on the map

DoCcK/UNDOCK MAP LEGEND

Use the following steps to undock, move, resize and re-dock the legend.

1. Click or tap the Legend icon in the bottom left menu panel.

a X

Active Incidents

=
@ Legend
V4
o

o Display Incident Mapping (AGOL)

Thermal IR Detects

2. Click or tap on the reduce window icon to undock the legend.

—
];;[ P T I o1 ];J : - ke = X L_':.I.
X :
@ Daockfundock
@ Legend Legend .
f . . f Active Incidents
Active Incidents
tal Display Incident Mapping (AGOL)
Ea) Display Incident Mapping (AGOL) o9
Thermal IR Detects
Thermal IR Detects |
p -1
|
H
¥
2 ;
Tue
? » I‘
e |
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3. Click or tap the Legend’s header to drag it elsewhere.

Q, Find Layers & Places

Layers

Add Layer

Basemap: Strests

Active Incidents

Display Incident Mapping (AGOL)

WFIGS - Wildland Fire Perimeters Current Year (All)
WFIGS - Wildland Fire Perimeters Current Year (Fin_
WFIGS - Wildland Fire Perimeters Current Decade
Airborne Intel Mapping - 40Y

Airborne Intel Mapping - 0AG

Airborne Intel Mapping - 327/328

Airborne Intel Mapping - 00V

v & X

Wyoming

Legend X N

Active Incidents -
Display Incident Mapping (AGOL)

Thermal IR Detects

Santa Fe
.

Q. Find Layers & Places ...

Layers

Add Layer

Basemap: Streets

Active Incidents

Display Incident Mapping (AGOL)

WFIGS - Wildland Fire Perimeters Current Year (All)

WFIGS - Wildland Fire Perimeters Current Year (Fin...

WFIGS - Wildland Fire Perimeters Current Decads

Airborne Intel Mapping - 40Y

Airborne Intel Mapping - 0AG

Airborne Intel Mapping - 327/328

Airborne Intel Mapping - 00V

vo@ X

® e —a—
7 i e
: G Lo
® ]
Viyoming [
Legend X
Active Incidents

Display Incident Mapping (AGOU

Thermal IR Detects

|
/ , 1
A %
Tm‘?rlcl Ci
>
° - \
! o Y
L ] ';
s
J
Santa Fe
I F

4. To resize the legend, move the mouse to the bottom right corner and drag the mouse to

adjust its size.

Legend

Active Incidents

Thermal IR Detects

Display Incident Mapping (AGOL)

- Armif
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5. Click or tap a layer to expand the data, click or tap the layer again to collapse the data.

Legend Legend

I Thermal IR Detects
@ MODIS Centroid

@ Otobhours @ 6tol2hours
@ 121024 hours 24 to 48 hours
over 48 hours

MODIS Footprint
0to 6 hours 610 12 hours
12 to 24 hours 24 10 48 hours

over 48 hours

6. Click or tap the resize window icon to re-dock the legend or click or tap X to close the

Legend.
RE-DOCK LEGEND CLOSE LEGEND
= F hacandiing
e . | r
Legend X & 1 Legend = D |
: T
Active Incident Dock/undock | Active Incident
Disp EI}"|5'|-25-3-5'5'|| ! : ent Ma AL \®
@ Thermal IR Detects o Thermal IR Detects
| H :
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TooLs

The Tools feature provides a list of tools to measure miles and acres, search for data, view
streaming data from aircraft, satellites and analyze the situation. The Tools Menu options vary

based on the open Workspace. The basic options in all Workspaces are free form search field,
Measure and Search Layers.

Zoom in or out on the map to narrow or broaden search perimeters.

= @ Intterra Maps

J Q, Find Tools & Places . ><
< Tools
f Measure »
‘@ Search Layers >
MEASURE ToOL

Select the measurement units for either Measure length, distance, or acres.
1. Click or tap the Tool Icon

2. Click or tap Measure

= @ Intterra Maps

Q. Find Tools & Places . ><

Tools

© 0

f Measure >

@ Search Layers >

3. Click or tap measurement unit's dropdown caret if different unit is needed instead of the
default options.
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4. Click or tap Measure Length or Measure Area

Measure

miles Measure Length

acres
laces |
hectares

sq. feet

5. miles

5. meters
5q. kilometers

Measure Area

5. The default draw option is to Trace. To change the draw option to single points at a time
click or tap Switch to Vertex. To cancel click or tap Cancel Drawing

© Intterra Maps

Batow C m Cli_ck each point of the line, then doubleclick when
'A T ﬂl‘\yon South Dal & finished.
< >< P Pierra
. o i L 1 %'
Measure '
-
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6. On the map click or tap
a. Hold the mouse or finger down to Trace the area.

b. Click or tap the mouse at each start and end point for the Vertex option

c. Double click or tap to stop drawing

‘ TRACE DRAWING VERTEX DRAWING

@

&

& ®

arlsbar &
> 1“ 8¢, %
[ ] ¢ 0‘ 4 S Midiana
‘ .UH'EI;E-E

- v s ¥

oK o e
B 8
5% .
|
<1

7. View the results.

8. When finished, click on Clear Measurements.

<

Measure

X

acres Measure Area
| Clear Measurements |
Area1-23.1M ac »
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SEARCH LAYERS

The Search Layers tool saves the user’s time and increases their search success by refining
their search to a specific layer or data field.

1. Click or tap the Tool Icon

2. Click or tap Search Layers

= & Intterra Maps

™y

Q. Find Tools & Places . ><

Tools

S © 0

Measure >

@I Search Layers >

3. Inthe Search text field enter the search perimeter.

1< X

Search Layers

&
g | = )
@ in layer. Active Incidents

group by: IncidentMame

show all [:] hide all Iil features O dens[t}l
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4. Choose additional filters using the in layer and/or group by options.

FILTER BY LAYER FILTER BY GROUP

Search Layers

() searchtext .

Search Layers

O, searchtext

in layer Active Incidents
Active Incidents
group by Display Incident Mapping {AGOL)

Thermal IR Detects

in layer. Active Incidenis
group by: IncidentMame
IncidentName

B showal [ Jnideall @ testures () density

show all | Incident #

—

5. View the results. Deselect a result by clicking on the incident name.

Search Layers

L
I & ' .
in layer Active Incidents a J ..." L
m 75
group by: IncidentMame S U i
pE.
showall | |hideall @ features density Uﬁl .
BTl
Catesby Fire (1) “
(854 dy |]
Morth Beaver Fire (1) L b;
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IR ALERT SUMMARY: INTELLIGENCE AND RESOURCES ONLY

This tool provides the users with alerts for possible new fires, emerging fires with a time-
coincident Initial Attack report from WildCAD, and extended attack fires close to an ICS-209 fire
and Event Severity score based on sensor infrared data for targeted location(s).

1. Click or tap on the intelligence & resources (ir) Workspace,

WOrKSDIES

-"/ ps /-i_r-\'.l
| peedict ——
- [N

=
(, nhaz ]
N

2. Click or tap on IR Alert Summary

];;[ C, Find Tools & Places ... ><
Tools
&
f Measure »
1
@ Search Layers >
IR Alert Summary »

Airborne Intel (All Aircraft)

60-day History by
Satellite Intel S
365 Days

—

©

3. Click or tap on the event
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4. Click or tap the zoom icon to zoom to the location

< © | X
IR Alert Summary T
Event GACC Event Source Event Type Process Date Event Severity

& Alaska Single IR Sensor IR Event 10/3/2023, 7:11:00 AM 2

5. Click or tap the back arrow < to return to the refreshed map

6. Click or tap the back arrow < to return to the previous screen, the X or Tool icon to
return to the Tools features screen.

= & Intterra Maps

Find Tools & Places .
| Q. Fir 0 e >< |
Tools N
% I
f Measure >
@' Search Layers > |
i
IR Alert Summary > |

Airborne Intel (All Aircraft)

60-day History b
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7. Click or tap on the mapped area for Navigation and additional Source details

NAVIGATION &

SELECTED FEATURES

IR EVENT

Route to Location
f Navigation
% Route to this location in external map

Selected Features

Alert Footprints
OTHER (1)

9 Pin: -163.9706, 54.7665

IR Event

General
EVENT_ACTIVE
1

EVENT_DATE
10/3/2023, 7:11:00 AM
EVENT_SEVERITY

2

EVENT_SOURCE
Single IR Sensor
EVENT_TYFE

IR Event
PROCESS_DATE
10/3/2023, 7:17:00 AM
ID

2170405
EVENT_FOOTPRINT
EVENT_GACC

Alaska

Geometry

Pin: -164.0065, 54.7788

General

LAT LON
54.77876,-164.00645
DMS

S54746'44'N 164°0'23"W
DDM

54°46.7254 -164°0.3871
USNG

3UWA 63903 70624
utm

3U 563903 6070624
THREE WORDS
regress.desk treated

Geometry

AIRBORNE INTEL: INTELLIGENCE AND RESOURCES ONLY

Provides near real-time access to view videos, imagery, and vector maps with heat perimeter,

hotspots, and detections.

1. Click or tap on the intelligence & resources (ir) Workspace

- — - .’. ) \

- ayv !
1 ' I I|
o __,/; .
{ nhaz
l“\\_ Py

2. The screen will refresh to show Airborne Intel under Tools

3. Click or tap the Missions, Incident or Nearby tab or use the search box and type the

mission or aircraft information.
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< X

Airborne Intel (all aircraft)

|w"53|cu5 INCIDENTS ~ NEAREY |

Q  Search By Mission Name, Incident, Etc ...

CA-HTE-OILSPILL on 3/8 72
1o 58 1. 43U/578

CA-PLU-HWY70SLIDE-NS7B on 3/8 o
1o 2@ 0 43U/578
@ CO-PBC-183-N3275F on 3/2 50.3m
AN 4@ 1w 377/328

4. The Mission summary includes:

a b C d e
CA-HTBOILSPILL on 3/8 77
| O 5@ - 3

f g h
a. State
b. Location

c. Type of Incident

d. Date

e. Miles/Distance

f.  Video icon: number of available videos (often includes audio)
g. Camera Icon: number of Satellite or aircraft images available
h. Vector icon: number of Aerial mapped views available

5. Click or tap on the Mission name to view the details
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6. The screen will refresh to show the mission’s name, status, zoom icon, and imagery
options with the default on the videos tab.

CA-HTB-OILSPILL [wcmve

43U/578
12:46 pm 03/08/2024

VIDEOS MAGES FEATURES

7. The most recent video or image will appear in the viewer window or at the top of the list

on each tab. A video, image or vector map can be downloaded by clicking the download
icon or archived/unarchived by clicking the archive icon.

LATEST @ SHOW ARCHIVEL
—, Aerial Footage -
4 140 hours ago g#

8. Videos: Click or tap the preferred video to watch, click or tap the two-sided arrow to
expand the screen. Turn the volume on to listen to the audio.

9. Images: Click or tap the preferred image, click or tap the two-sided arrow to expand the
screen.
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10. Features: click or tap the preferred Vector Map; click or tap the two-sided arrow to
expand the screen.

VIDEO TAB IMAGES TAB FEATURES TAB

CA-HTB-OILSPILL (e CA-HTB-OILSPILL [wcme CA-HTB-OILSPILL [wcawe

43U/57B 43U/578 43U/578
12:46 pm 03/08/2024 12:46 pm 03/08/2024 12:46 pm 03/08/2024

Download TS File wrest O & G

< Heat Perimeter: 15acres 3
& 140 nours ago Gado

. = i, L,

west 0@ L@

wrest O &L @

— Aerial Image - Infrared
= 140 hours ago Qaeg

= Aerial Footage 3
™ 140 hours ago 0L

— Aerial Image - Custom
— 140 hours ago

— Aerial Footage
— 140 hours ago

11. Click X to close the window and go back to the main screen.
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SATELLITE INTEL: INTELLIGENCE AND RESOURCES ONLY

Provides satellite imagery based on Missions, Incidents or Nearby locations with heat perimeter,
hotspots, and detections.

1. Click or tap on the intelligence & resources (ir) Workspace

2. Click or tap on Satellite Intel.

l;;[ Q, Find Tools & Places .. h 4
Tools

2

f Measure >

@ Search Layers >

IR Alert Summary >
Airborne Intel (All Aircraft)
60-day History ?
Satellite Intel >
365 Days

©

3. Click or tap the Missions, Incident or Nearby tab or use the search box and type the
fire incident name

1 < X
Satellite Intel

=
MISSIONS INCIDENTS NEARBY

f Q. Search By Mission Name, Incident, Etc ...

@ WVO3SWIR in 2023 s
I 1@ om SR
W03 in 2023 55807 -
I 2@ O -edm
WW03in 2023 S5r0sam
I 1A M R
WWO3SWIR in 2023 -
Im 1A Om e

@ WWO3SWIR in 2023 -
I 1@ om e
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4. Click on the Fire event name under the Missions, Incidents or Nearby tab.

MISSIONS INCIDENTS NEARBY
< X % bg o | < X
Satellite Intel satellite Intel < Satellite Intel
t 7| q i Ete.. L
ncident, Etc

WVO3SWIR in 2023 S2Gin 2023

= 1o WVO3SWIR in 2023 o = 20 0
WV03 in 2023 N e V02 in 2023

[}

) WV03in 2023 7
WV03in2023 57923 D o B 0

1

WVO3SWIR in 2023

= a 0m
WV03 in 2023

WVO3SWIR in 2023 0 o™ a 0

WVO3SWIR in 2023
[2] - . 2

WV02 in 2023
WVO03SWIR in 2023 Jae 2@ 0
- a 0

5. Click or tap on the desired image and click on the zoom icon. The image will appear on
the map. Click or tap on the double-sided arrow to expand the image.
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P “'\% || ]
B S ,-l}l River Bend \
i ¥y _
WV03 [mscme| P 2 G
nifcsatelliteimagery - GREAT L AKES ‘ r.l
01:00 pm 05/72/2023 i '\
VIDEOS ~ IMAGES  FEATURES I|I i
5 /l' Pdlocksville |I
NC-Highwaylse 1
| .
[ |
| |
% z
~ 1
s\ 4 ;IF
= Maysvill
west 0@ L@ SHOW ARCHIVED '._}JJ" Rk

O Aerial Image - Customn
10 months ago

O Aerial Image - Customn
10 months ago

O Aerial Image - Customn
10 months ago

Aerial Image - Custom "
& 10 months ago BLa®oO

O Aerial Image - Customn
10 months ago

Pl

6. The image can be downloaded by clicking the download icon or archived/unarchived by
clicking the circle with the x.

= Aerial Image - Customn 3
v 10 months ago 0L &

7. Click X to close the window and go back to the main screen.

. T

WV03 | macme

nifcsatelliteimagery - GREAT L AKES
01:00 pm 05/22/2023
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